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Гарантийные обязательства МАРАФОНА.     
ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА
(Ограниченная гарантия на продукцию МАРАФОНА)
 

Программное обеспечение:
Гарантийное  обслуживание  по  программному  обеспечению  можно  получить, 
связавшись с офисом МАРАФОНА в оговоренный гарантийный период. Адрес офиса 
МАРАФОНА приведен на первой странице Руководства по эксплуатации устройства, 
а также приложен вместе с Регистрационной карточкой. 

МАРАФОН гарантирует, что его программное обеспечение будет работать в строгом 
соответствии  с  прилагаемой  к  нему  МАРАФОНОМ  документацией  в  течении 
девяноста (90) дней с момента его приобретения у МАРАФОНА или Авторизованного 
Реселлера.  МАРАФОН  предоставляет  гарантию  на  носитель,  на  котором 
поставляется программное обеспечение,  в виде отсутствия потери им информации 
на  тот  же  гарантийный  срок.  Данная  гарантия  имеет  отношение  только  к 
приобретенному  программному  обеспечению  или  его  замене  по  гарантии,  и  не 
касается  любых  обновлений  или  замен,  которые  получены  через  Internet  или 
бесплатно.

Ответственность МАРАФОНА по обеспечению гарантии программного обеспечения 
состоит в замене его на новое,  которое выполняет перечисленные в  прилагаемой 
документации  функции.  Ответственность  Заказчика  состоит  в  выборе 
соответствующего приложения, программной платформы/системы и дополнительных 
материалов.  МАРАФОН  не  отвечает  за  работоспособность  программного 
обеспечения  вместе  с  любыми  аппаратными  средствами  и/или  программными 
платформами/системами,  которые  поставляются  третьими  сторонами,  если 
совместимость  с  ними  не  оговорена  в  прилагаемой  к  продукции  МАРАФОН 
документации.  Согласно  данной  гарантии,  МАРАФОН  старается  обеспечить 
разумную совместимость своей продукции, но МАРАФОН не несет ответственность, 
если с аппаратными или программными средствами третьих фирм происходят сбои. 
МАРАФОН не гарантирует, что работа программного обеспечения будет непрерывна 
и  в  процессе  не  будут  происходить  ошибки,  а  также  то,  что  все  дефекты  в 
программном продукте с или без учета документации на него, будут исправлены.

Ограничения гарантий
Вышеупомянутые гарантии и замечания являются исключительными и соответствуют 
всем  прочим  гарантиям,  объявленным  или  подразумеваемым,  которые  даются  в 
явном виде или в соответствии с законодательством, установленными законами или 
в другом виде, включая гарантии на сам товар и его пригодность для стандартных 
целей.  МАРАФОН  никогда  не  допускает  и  не  принимает  на  себя  прочую 
ответственность,  связанную  с  продажами,  поддержкой  инсталляции  или 
использования продукции МАРАФОНА

МАРАФОН  никогда  не  несет  ответственность  по  гарантии,  если  проводимое  им 
тестирование  и  анализ  определяет,  что  заявленный  дефект  в  изделии  не  был 
обнаружен, или он был вызван неверным использованием заказчиком, или третьей 
стороной,  невнимательной  или  неправильной  инсталляцией  или  тестированием, 
попыткой  ремонта  неавторизованными  лицами,  или  чем-либо  еще,  не 
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предусмотренным в  назначении изделия,  типа несчастного  случая,  огня,  пожара и 
других бедствий. 

Ограничения ответственности
Ни в каком случае МАРАФОН не несет ответственность за любые убытки, включая 
потерю  данных,  потерю  прибыли,  стоимости  покрытия  или  других  случайных, 
последовательных  или  непрямых  убытков,  являющихся  следствием  инсталляции, 
сопровождения, использования, производительности, неисправности или временной 
неработоспособности  изделий  производства  МАРАФОНА.  Эти  ограничения 
действуют, даже если МАРАФОН был предупрежден о возможности такого убытка. 

Регистрационная карточка,  прилагаемая на обратной стороне Руководства,  должна 
быть  отправлена  в  офис  МАРАФОН  по  факсу,  электронной  почте  или  почтовым 
отправлением. Список адресов/ телефонов/ факсов офисов МАРАФОНА содержится 
на первой странице данного Руководства.

Юр. адрес: 117330 Москва, ул. Мосфильмовская, дом 17Б.
Факт. адрес: 119899 Москва, Ленинске горы, МГУ, НИИЯФ, д.1. стр.5. 
Тел. (495)-988-27-26, 939-56-59, 939-13-24 
Факс. (495)-939-56-59
E-mail: support@marathon.ru 
WEB: www.marathon.ru 

По техническим вопросам звоните по тел. +7 (495)-988-27-26, 939-56-59, 939-13-24 
или свяжитесь с нами по email support@marathon.ru. 
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Лицензионное соглашение на Программное 
обеспечение, поставляемое с CAN интерфейсами 

производства МАРАФОН

Все права на программное обеспечение, аппаратное обеспечение 
и  данное  руководство  принадлежат  фирме  Марафон  и 
защищены законодательством Российской Федерации.
ПЕРЕД  ИСПОЛЬЗОВАНИЕМ  ПРИЛАГАЕМОГО  ИЗДЕЛИЯ 
ПОКУПАТЕЛЬ  ДОЛЖЕН  ВНИМАТЕЛЬНО  ОЗНАКОМИТЬСЯ  С 
УСЛОВИЯМИ  НАСТОЯЩЕГО  СОГЛАШЕНИЯ.  ИСПОЛЬЗОВАНИЕ 
ДАННОГО  ИЗДЕЛИЯ  ПОДРАЗУМЕВАЕТ  ПРИНЯТИЕ  ЭТИХ 
ПОСТАНОВЛЕНИЙ  И  УСЛОВИЙ.  ЕСЛИ  ОГОВОРЕННЫЕ  УСЛОВИЯ 
ЯВЛЯЮТСЯ  ДЛЯ  ПОКУПАТЕЛЯ  НЕПРИЕМЛЕМЫМИ,  ОН  ДОЛЖЕН 
НЕЗАМЕДЛИТЕЛЬНО ВЕРНУТЬ НЕИСПОЛЬЗОВАННЫЙ КОМПЛЕКТ, 
ПРИ ЭТОМ ЗАТРАТЫ ПОКУПАТЕЛЯ БУДУТ ВОЗМЕЩЕНЫ.
ДАННЫЙ  ДОКУМЕНТ  ЯВЛЯЕТСЯ  ЛИЦЕНЗИОННЫМ 
СОГЛАШЕНИЕМ, НО НЕ СОГЛАШЕНИЕМ О ПРОДАЖЕ.  МАРАФОН 
ЯВЛЯЕТСЯ  ВЛАДЕЛЬЦЕМ  ИЛИ  ИМЕЕТ  ЛИЦЕНЗИОННЫЕ 
СОГЛАШЕНИЯ С ДРУГИМИ ВЛАДЕЛЬЦАМИ АВТОРСКИХ ПРАВ НА 
ПРОГРАММНОЕ  ОБЕСПЕЧЕНИЕ,  ВХОДЯЩЕЕ  В  КОМПЛЕКТ 
ПОСТАВКИ  СВОИХ  ИЗДЕЛИЙ  И  ПО.  ПОКУПАТЕЛЬ  НЕ 
ПРИОБРЕТАЕТ  НИКАКИХ  ПРАВ  НА  ИНТЕЛЛЕКТУАЛЬНУЮ 
СОБСТВЕННОСТЬ,  СОДЕРЖАЩУЮСЯ  В  ПРОГРАММНОМ 
ОБЕСПЕЧЕНИИ,  ЗА ИСКЛЮЧЕНИЕМ  ТЕХ,  КОТОРЫЕ  НАСТОЯЩЕЕ 
СОГЛАШЕНИЕ  ПРЕДОСТАВЛЯЕТ  ЕМУ  В  ОТНОШЕНИИ  ЭТОГО 
ПРОГРАММНОГО  ОБЕСПЕЧЕНИЯ.  ПРАВО  СОБСТВЕННОСТИ  НА 
ПРИЛАГАЕМУЮ  КОПИЮ  УПОМЯНУТОГО  ПРОГРАММНОГО 
ОБЕСПЕЧЕНИЯ,  А  ТАКЖЕ  НА  ВСЕ  КОПИИ,  СДЕЛАННЫЕ  С  НЕЕ, 
СОХРАНЯЕТСЯ  ЗА  МАРАФОНОМ  ИЛИ  ДРУГИМИ  ВЛАДЕЛЬЦАМИ 
АВТОРСКИХ  ПРАВ.  ПОКУПАТЕЛЬ  ПРИНИМАЕТ  НА  СЕБЯ  ВСЮ 
ОТВЕТСТВЕННОСТЬ  В  ОТНОШЕНИИ  ВЫБОРА  ПРОГРАММНОГО 
ОБЕСПЕЧЕНИЯ  ДЛЯ  ДОСТИЖЕНИЯ  СВОИХ  ЦЕЛЕЙ,  А  ТАКЖЕ  ЗА 
УСТАНОВКУ, ИСПОЛЬЗОВАНИЕ И РЕЗУЛЬТАТЫ ИСПОЛЬЗОВАНИЯ 
ДАННОГО ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ.
Покупатель имеет право:
1.  копировать  Программное  обеспечение  исключительно  для  создания 
резервных  копий  или  при  установке  для  подразумеваемого  обычного 
использования Программного обеспечения при условии, что в любой копии 
упомянутого  Программного  обеспечения  будут  воспроизведены  все 
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уведомления  об  авторских  правах  и  торговых  марках,  содержащиеся  в 
данном Программном обеспечении;
2. передавать право владения копиями Программного обеспечения другому 
юридическому  или  физическому  лицу  путем  передачи  данной  копии 
настоящего Соглашения и всей прочей документации, а также по меньшей 
мере  одной полной и не  претерпевший изменений копии Программного 
обеспечения,  при  условии,  что  (1)  все  сделанные  Покупателем  копии 
Программного  обеспечения  будут  переданы  означенному  лицу  или 
уничтожены, (2) такая передача права владения прекращает лицензионное 
соглашение Покупателя с МАРАФОНОМ, и (3) означенное лицо примет на 
себя и будет соблюдать постановления данного лицензионного соглашения 
с момента начала пользования Программным обеспечением; и
3. использовать торговые марки, связанные с Программным обеспечением, 
исключительно в соответствии с существующей практикой использования 
торговых марок, включая ссылки на имена владельцев торговых марок.
Без письменного согласия МАРАФОНА запрещается:
1.  использовать, копировать,  изменять, объединять или передавать копии 
данного  Программного  обеспечения  при  условиях,  отличных  от 
оговоренных в данном соглашении;
2. деассемблировать или декомпилировать Программное обеспечение;
3.  выдавать  сублицензию,  сдавать  в  аренду  и  лизинг,  передавать  в 
пользование данное Программное обеспечение или любую его копию.

Копирование  этого  руководства  возможно  только  при  получении 
письменного разрешения у фирмы Марафон.
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Программа CANwise                                                         Введение

1. ВВЕДЕНИЕ
Этот  документ  описывает  установку  и  использование 
программы  CANwise в  операционных  системах  Linux, 
Windows XP/Vista/7. 

ПЕРЕД  УСТАНОВКОЙ  ПРОГРАММЫ  ВНИМАТЕЛЬНО 
ОЗНАКОМЬТЕСЬ  С  ИНСТРУКЦИЕЙ  ПО  УСТАНОВКЕ  И 
УДАЛЕНИЮ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ CANwise.

CANwise  представляет  собой  универсальную  программу 
тестирования и конфигурирования сети CAN, с графическим 
пользовательским  интерфейсом.  Конкретная 
функциональность  программы  определяется  подгружаемыми 
модулями  (plug-ins).  В  базовой  версии  программа  CANwise 
поставляется с подгружаемым модулем монитора сети  CAN – 
CANmonitor,  который  позволяет  работать  с  сетью  CAN на 
канальном  уровне  и  модулем  трассировщика  -  CANtracer. 
Дополнительные  подгружаемые  модули  поставляются 
отдельно  со  своей  документацией  по  установке  и 
использованию. Примечание: в CANwise версии 3.x изменен 
интерфейс подгружаемых модулей, поэтому модули версии 
2.x нельзя использовать для работы в составе CANwise 3.x. 

Для  доступа  к  аппаратуре  CAN программа  CANwise 
использует  библиотеку  CHAI,  которая  должна  быть 
установлена в системе.  CANwise версии 3.3  и выше требует 
установленной  в  системе  библиотеки  CHAI  версии  2.3.0 
или  более  поздней. CANwise поддерживает  работу  с 
аппаратным  обеспечением  CAN,  которое  поддерживается 
библиотекой CHAI.
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2. УСТАНОВКА ПРОГРАММЫ
Для  работы  программа  CANwise требует  установленную  в 
системе  библиотеку  CHAI  версии  2.x.x.  Инструкции  по 
установке  CHAI в  вашу операционную  систему  смотрите  в 
руководстве  пользователя  библиотеки  CHAI,  которое 
поставляется с аппаратными CAN-интерфейсами производства 
фирмы Марафон, а также доступно в электронном виде через 
Web по  адресу  http  ://  can  .  marathon  .  ru  /  ;  это  руководство также 
входит в состав дистрибутива библиотеки CHAI.

2.1. ОС Windows XP/Vista/7

1. Удалите  предыдущую  версию  программы,  для  этого 
запустите мастер удаления: Start->Programs->CANwise-
3.x->Uninstall.

2. Запустите исполняемый файл  CANwise-3.5-win32.exe и 
следуйте инструкциям установочной программы. 

2.2. ОС Linux

Для  установки  программы  CANwise в  ОС  Linux  вам 
необходимо иметь установленную в системе GUI-библиотеку 
GTK+ версии  2.22 или  выше.  Кроме  того,  вам  понадобится 
архиватор tar и команда make (обычно установлены в системе). 
Поскольку Linux  является  ОС ориентированной  на  поставку 
программного  обеспечения  в  исходных  кодах,  а  CANwise 
поставляется в бинарном виде, фирма Марафон не гарантирует 
работоспособности CANwise во всех дистрибутивах ОС Linux. 
Данная  версия  CANwise  разрабатывалась  и  тестировалась  в 
дистрибутиве  Linux:  Ubuntu  10.10  (с  установленной 
библиотекой GTK+ 2.22). Для установки CANwise вы должны 
обладать правами root. Скачайте архив canwise-3.5-linux.tar.gz 
и распакуйте его в директорию /opt командой.
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tar -C /opt -xzvf canwise-3.5-linux.tar.gz

Перейдите  в  директорию  куда  был  распакован  архив  и 
выполните команду make install

cd /opt/canwise-3.5-linux

make install

Теперь  вы  можете  запустить  CANwise  набрав  в  терминале 
команду canwise

canwise
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3. УДАЛЕНИЕ ПРОГРАММЫ

3.1. ОС Windows XP/Vista/7

Запустите мастер удаления CANwise: 

Start->Programs->CANwise-3.5->Uninstall CANwise.

3.2. ОС Linux

Для  удаления  дистрибутива  выполните  находясь  в 
установочной  директории  команду  make  uninstall,   затем 
удалите установочную директорию.

cd /opt/canwise-3.5-linux

make uninstall
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4. ИСПОЛЬЗОВАНИЕ ПРОГРАММЫ 
CANWISE 

4.1. Запуск программы

Для запуска программы в ОС Windows используйте 

Start->CANwise-3.5->canwise

Для запуска в ОС Linux наберите в терминале команду canwise

canwise

Сразу после запуска программа выводит диалог выбора канала 
ввода/вывода CAN.
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Программа  CANwise для  доступа  к  сети  использует 
библиотеку  CHAI,  которая поддерживает  до  8  CAN-
контроллеров в одном компьютере. Каждый CAN контроллер 
рассматривается  как  отдельное  устройство  и  ему  в 
соответствие  ставится  отдельный  независимый  канал  ввода-
вывода CAN. 

Диалог  выбора  канала  CANwise выводит  список 
обнаруженных  библиотекой  CHAI аппаратных  CAN-
интерфейсов  и  каналов  ввода-вывода,  которые  им 
соответствуют.  Для  продолжения  работы  следует  выбрать 
канал и один из трех доступных форматов кадров с которыми 
предполагается работать (только 11-битовые идентификаторы, 
только  29-битовые  идентификаторы,  оба  формата 
одновременно). Режим работы канала также влияет на работу 
аппаратного фильтра CAN-контроллера (об установке фильтра 
в  программе  смотрите  пункт  “Управление  каналом  ввода-
вывода CAN” ниже). Некоторые CAN-контроллеры позволяют 
использовать кадры обоих форматов одновременно, например 
Phillips SJA1000,  но  при  этом алгоритм работы аппаратного 
фильтра может быть разным, несовместимым между разными 
форматами  кадров.  В  библиотеке  CHAI (и  в  программе 
CANwise соответственно) есть три режима работы:

• только  11-битовые  идентификаторы  -  стандартный 
формат кадра;  вы можете посылать/принимать  только 
кадры  стандартного  формата,  функция  установки 
фильтра  использует  алгоритм  для  стандартного 
формата.

• только  29-битовые  идентификаторы  -  расширенный 
формат кадра;  вы можете посылать/принимать  только 
кадры  расширенного  формата,  функция  установки 
фильтра  использует  алгоритм  для  расширенного 
формата.
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• оба  формата  одновременно;  вы  можете 

посылать/принимать  кадры  как  расширенного  так  и 
стандартного  формата,  функция  установки  фильтра 
использует алгоритм установки для СТАНДАРТНОГО 
формата,  при  этом  действие  фильтра  на  кадры 
расширенного формата непредсказуемо.

В колонке Chan state выводится информация о том занят канал 
в момент запуска CANwise или свободен. Вы можете выбрать 
только свободный канал. Следует принимать во внимание тот 
факт,  что  информация  о  занятости  каналов  соответствует 
только моменту запуска диалога выбора каналов. Если какой-
то занятый канал был освобожден после запуска диалога,  то 
эта  информация  не  будет  отображена.  Для  обновления 
информации о каналах необходимо перезапустить CANwise.

В последней колонке Serial number выводится серийный номер 
устройства, если он поддерживается данным типом устройства 
(в  настоящий  момент  серийные  номера  поддерживаются 
только устройствами CAN-bus-USBnp/CAN-bus-USBnps).

После выбора канала ввода-вывода и формата кадра нажмите 
кнопку «OK». 

Кнопка «Load Session» позволяет загрузить сохраненный ранее 
сеанс работы (см. ниже пункт «Работа с сеансами»).

В случае,  если библиотека  не смогла обнаружить  ни одного 
аппаратного  CAN-интерфейса,  программа  CANwise выводит 
диалог ошибки и завершает работу.
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4.2. Главное окно программы

После  выбора  канала  на  экран  выводится  главное  окно 
программы. В левой части окна находятся кнопки управления 
каналом  ввода-вывода  CAN (CAN channel controls), 
индикаторы  ошибок  сети  CAN и  список  отображающий 
состояние  канала  ввода-вывода  и  CAN-контроллера  (CAN 
channel information). В правой верхней части окна находится 
рабочая область  подгружаемых модулей  CANwise,  в  данном 
случае она пуста поскольку ни один модуль не загружен.
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4.3. Управление загружаемыми модулями

Для  вывода  диалога  списка  обнаруженных  подгружаемых 
модулей  следует  вызвать  меню  Plugins->Configure  (см. 
рисунок).

По  умолчанию  в  стандартной  поставке  это  будет  список  из 
одного модуля  CANmonitor  – монитора сети CAN. Каждый 
модуль  из  списка  можно  загрузить  в  рабочую  область 
нажатием кнопки «Load».

Загруженный  модуль  можно  выгрузить  из  памяти  нажатием 
кнопки «Release».
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4.4. Управление каналом ввода-вывода CAN

• Кнопка  «Start/Stop»  –  переводит  CAN-контроллер  в 
состояние  RUNNING/INIT.  После  запуска  программы 
CAN-контроллер находится  в состоянии  INIT.  В этом 
состоянии контроллер “отключен” от сети (не участвует 
в  обмене  данными  и  в  схеме  обнаружения  ошибок), 
только в этом состоянии возможно конфигурирование 
контроллера  (установка  приемного  фильтра,  скорости 
передачи,  включение/отключение  режима  Listen Only 
Mode).  В  режиме  RUNNING контроллер  находится  в 
рабочем  режиме  и  участвует  в  полноценном  обмене 
данными  с  другими  узлами  сети,  конфигурирование 
контроллера в этом состоянии невозможно.

• Кнопка «Baud» – вызывает диалог установки скорости 
передачи (по умолчанию после запуска программы 
скорость передачи равна 500 Kbaud).
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Диалог позволяет выбрать из списка одну из 
предопределенных скоростей передачи, либо выбрав 
пункт “Manual Set” выставить конкретное значение 
регистров bt0 и bt1 для задания нестандартной скорости 
(более подробно о значении регистров bt0 и bt1 и 
расчете скорости передачи читайте в документации 
контроллера SJA1000).

• Кнопка «Filter» – вызывает диалог установки приемного 
фильтра CAN-контроллера.
 

Текущая версия программы CANwise поддерживает 
аппаратный фильтр как для кадров стандартного 
формата (идентификатор – 11 бит), так и для кадров 
расширенного формата  (идентификатор – 29 бит). 
Следует только учитывать (как уже указывалось выше), 
что при открытии канала в режиме работы с обоими 
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форматами кадров используется алгоритм установки 
фильтра для СТАНДАРТНОГО ФОРМАТА, действие 
фильтра на кадры расширенного формата 
непредсказуемо. Если вам необходимо установить 
фильтр для кадров расширенного формата открывайте 
канал в режиме работы только с кадрами расширенного 
формата. 

Аппаратный фильтр состоит из двух значений: Filter 
code (acode) - значение фильтра, и Filter mask (amask) - 
значение маски. Значение фильтра задает 
идентификатор принимаемых кадров. Маска задает 
значащие позиции в значении фильтра. Если бит номер 
N в маске выставлен в 1, то бит номер N в значении 
фильтра должен быть равен биту N в идентификаторе 
принимаемого кадра для успешного прохождения этого 
кадра через фильтр. Если бит номер N в маске 
выставлен в 0, то биты номер N в значении фильтра и 
идентификаторе принимаемого кадра не сравниваются. 
 
Например, установить аппаратный фильтр контроллера 
на прием только кадров с идентификаторами от 0x0 до 
0x7 включительно: Filter code = 0x0, Filter mask = 0xfff8, 
здесь маска 0xfff8 указывает, что первые три бита 
идентификатора не участвуют в сравнении, а остальные 
должны совпадать с 0. Таким образом, через фильтр 
будут проходить кадры с идентификаторами от 0x0 до 2 
в степени 3 минус 1 (т.е. 0x7). Другой пример, 
установить аппаратный фильтр контроллера на прием 
всех кадров: Filter code = 0x0, Filter mask = 0x0.

• Кнопка «Reset» – производит аппаратный сброс  CAN-
контроллера;  сбрасываются  все  аппаратные  и 
программные  счетчики  ошибок  и  переполнений,  а 
также  индикаторы  ошибок  сети  CAN  (см.  ниже); 
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скорость  передачи,  аппаратный  фильтр  и  состояние 
контроллера (INIT/RUNNING) сохраняются.

• Кнопка «Set LOM/Clear LOM» - переводит контроллер 
в/из  режим  Listen-Only-Mode,  в  этом  режиме 
контроллер не участвует в работе шины (не шлет кадры 
подтверждения  и  ошибок)  но  только  принимает 
проходящие  по  сети  кадры,  этот  режим используется 
для  не  возмущающего  тестирования  CAN-сетей. 
Передача кадров в сеть в режиме LOM – невозможна.

• Кнопка  «Close»  –  закрывает  текущий  канал  ввода-
вывода  CAN,  освобождая  все  ресурсы  программы  и 
операционной  системы  связанные  с  ним,  и  вызывает 
стартовый диалог выбора нового канала (соответствует 
перезапуску программы).
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4.5. Информация об ошибках сети CAN

Индикатор  ошибки  загорается  красным  цветом  при  ее 
появлении.  Для  сброса  индикаторов  используйте  кнопку 
аппаратного сброса CAN-контроллера Reset.

• "EWL     error warning limit" – Error Warning Level, один 
из  аппаратных  счетчиков  ошибок  CAN-контроллера 
превысил уровень предупреждения (по умолчанию 96); 
кроме  указаных  в  предыдущем  пункте  (WTOUT) 
причиной  возникновения  этой  ошибки  могут  быть 
помехи в сети (согласно спецификации Bosch CAN 2.0);

• "BOFF    bus off" – контроллер отключен от сети из-за 
ошибок (один из счетчиков ошибок достиг предельного 
значения 255);  При наступлении этого события  CAN-
контроллер автоматически переходит в состоянии INIT;

• "HOVR    hardware overrun" – произошло переполнение 
аппаратной  приемной  очереди  CAN-контроллера 
(безвозратно потерян один или несколько полученных 
кадров), причина – большой поток кадров в сети, ЦПУ 
не  успевает  вынимать  кадры  из  аппаратной  очереди 
контроллера;

• "SOVR    software overrun" – произошло переполнение 
программной  приемной  очереди  драйвера 
(безвозвратно потерян один или несколько полученных 
кадров),  причина  –  большой  поток  кадров  в  сети, 
пользовательское  приложение  (в  данном  случае 
программа CANwise)  не  успевает  вынимать  кадры  из 
программной очереди драйвера;
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• “WTOUT   write timeout occured" – кадр не был отослан 

в течении стандартного временного интервала, ошибка 
может  возникнуть  если  нет  соединения  с  сетью 
(например,  обрыв  кабеля,  нет  других  контроллеров  в 
сети, несоответствие выставленных скоростей передачи 
у контроллеров в сети);
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4.6. Информация о канале ввода-вывода и 
состоянии CAN-контроллера

В  левой  части  главного  окна  CANwise находится  список 
отображающий  текущее  состояние  канала  ввода-вывода  и 
CAN-контроллера (CAN channel information).

Здесь выводится:

• channel – номер используемого канала ввода-вывода;

• state – текущее состояние CAN-контроллера канала – 
INIT или RUNNING. В состоянии INIT контроллер 
“отключен” от сети, не участвует в обмене данными и в 
схеме обнаружения ошибок. Только в этом состоянии 
возможно конфигурирование контроллера,  то есть 
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установка приемного фильтра, скорости передачи, 
включение/отключение режима Listen Only Mode. В 
режиме RUNNING контроллер находится в рабочем 
режиме и участвует в полноценном обмене данными с 
другими узлами сети, конфигурирование контроллера в 
этом состоянии невозможно;

• hw overruns – количество возникших переполнений 
аппаратной приемной очереди CAN контроллера (этот 
счетчик сбрасывается в ноль при аппаратном сбросе 
контроллера). Аппаратное переполнение возникает в 
случае когда контроллер получает из сети кадр и 
обнаруживает что аппаратная очередь заполнена. Тогда 
контроллер сбрасывает полученный кадр (кадр теряется 
безвозвратно) и генерирует прерывание, счетчик 
показывает количество таких возникших прерываний;

• sw overruns - количество возникших переполнений 
программной приемной очереди драйвера CAN 
контроллера (этот счетчик сбрасывается в ноль при 
аппаратном сбросе контроллера). Программное 
переполнение возникает в случае когда драйвер 
получает от контроллера прерывание о получении кадра 
из сети (в этот момент кадр уже находится в аппаратной 
очереди контроллера) и обнаруживает что программная 
приемная очередь заполнена, тогда драйвер сбрасывает 
полученный кадр (кадр теряется безвозвратно) и 
увеличивает счетчик программных переполнений;

• baud rate – текущая (выставленная пользователем) 
скорость передачи;

• filter code, filter mask – код и маска приемного фильтра 
(выставленного пользователем);

• frame format – используемый формат кадров;
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• base address – базовый адрес области памяти куда 

отображаются  регистры CAN-контроллера;

• irq – номер линии прерывания используемой CAN-
контроллером канала;

• board – номер платы CAN-интерфейса, который 
содержит CAN-контроллер используемого канала 
ввода-вывода;

• board name – название платы CAN-интерфейса;

• board manufacturer – имя компании производителя 
платы;

• CAN chip – тип CAN-контроллера;

• Ниже выводятся текущие значения регистров 
конкретного CAN-контроллера установленного на 
аппаратном CAN-интерфейсе; например, для 
контроллера SJA1000 назначение каждого регистра и 
смысл его значений приводятся в документации на 
Phillips SJA1000;

4.7. Завершение работы программы

Для завершения работы программы выберите File->Quit.

4.8. Работа с сеансами

CANwise  позволяет  сохранять  состояние  программы  между 
сеансами работы в файл.  Файлы сеансов имеют расширение 
.cws. 

В файле сеанса CANwise сохраняет следующую информацию:

 номер канала ввода-вывода,
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 формат кадра,

 скорость передачи,

 список загруженных модулей,

 геометрические размеры главного окна программы.

Для  сохранения  сеанса  работы  выберите  File->Save  session, 
затем в появившемся диалоге выберите файл и нажмите Save.

Для загрузки сохраненного сеанса можно использовать кнопку 
«Load session»  стартового диалога выбора канала (см. пункт 
Запуск программы), или меню File->Load session. 

В  ОС  Windows  загрузить  сохраненный  сеанс  также  можно 
двойным щелчком мыши на файле сеанса. 

В ОС Linux  загрузить сохраненный сеанс можно передав имя 
файла сеанса в качестве первого параметра. Например,

canwise /root/cwses-ch0.cws

4.9. Установка нового загружаемого модуля в 
программу CANwise

Примечание:  в  CANwise  версии  3.x  изменен  интерфейс 
подгружаемых модулей, поэтому модули версии 2.x нельзя 
использовать для работы в составе CANwise 3.x.

Для инсталляции загружаемого модуля в программу CANwise 
необходимо  поместить  файл  нового загружаемого модуля (в 
ОС  Windows - это файл с расширением .dll,  в ОС  Linux – с 
расширением  .so)  в  установочную  директорию  программы 
CANwise,  то  есть  директорию где лежит исполняемый файл 
программы.  После  этого  необходимо  перезапустить 
программу,  чтобы  она  могла  обнаружить  новый  модуль. 
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Например,  если  в  ОС  Windows программа  CANwise 
установлена  в  директорию  C:\CANwise-3.5,  то  для 
инсталляции  модуля  достаточно  скопировать  его  файл  в 
директорию C:\CANwise-3.5, и перезапустить программу.
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5. ИСПОЛЬЗОВАНИЕ ПОДГРУЖАЕМОГО 
МОДУЛЯ CANMONITOR

Подгружаемый  модуль  CANmonitor входит  в  стандартную 
поставку программы  CANwise и позволяет работать  с сетью 
CAN на канальном уровне, а именно:

• Выводит на экран все пакеты проходящие по сети;

• Позволяет посылать пакеты произвольного содержания 
в сеть;

• Может записывать весь трафик (как принимаемые так 
и отправляемые кадры) в лог-файл для дальнейшего 
анализа;
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5.1. Вывод полученных кадров на экран

Сразу  после  запуска  программы  CANwise CAN-контроллер, 
находится  в  состоянии  INIT.  Для  перевода  контроллера  в 
состояние RUNNING (соединение с сетью) необходимо нажать 
кнопку  Start  основного модуля  CANwise. При установленном 
соединении  с  сетью  модуль  CANmonitor выводит  все 
проходящие по сети кадры в свое рабочее окно.

Кнопка  «Clear  Output»  очищает  рабочую  область  модуля  и 
сбрасывает счетчики полученных и отправленных кадров.

Раскрывающийся  список  перед  кнопкой  «Clear  Output» 
позволяет выбрать формат вывода поля данных полученного 
CAN-кадра:  HEX  –  шестнадцатеричный  формат,  DEC  – 
десятичный, ASC – формат ASCII.

Полученные  CAN-кадры  выводятся в  формате  с  полями 
фиксированного размера:

EV NUM/ERR F/F ID LEN R/D D0 D1 D2 D3 D4 D5 D6 D7 TIMESTAMP

Здесь:

• EV [событие]  -  RX указывает  на  полученный,  TX на 
отправленный  кадр,  ER  указывает  на  асинхронную 
ошибку сети (см. следующий пункт);

• NUM/ERR  [номер  кадра]  –  счетчик 
полученных/отправленных  кадров;  счетчик  ведет  счет 
до  9  999  999  кадров,  затем  обнуляется;  выводится  в 
формате десятеричных чисел; 

• F/F  [формат  кадра]  –  SFF  указывает  на  кадр 
стандартного формата (идентификатор имеет длину 11 
бит),  EFF  указывает  на  кадр  расширенного  формата 
(идентификатор имеет длину 29 бит);
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• ID [идентификатор] – значение идентификатора кадра, 

выводится в формате шестнадцатеричных чисел ;

• LEN [длина] - длина поля данных в байтах (от 0 до 8 
байт);

• R/D  (RTR/HEX/DEC/ASC)  –  RTR  указывает  на  кадр 
RTR  (поле  данных  отсутствует),  HEX/DEC/ASC 
указывает на кадр данных  (HEX – шестнадцатеричный 
формат  вывода,  DEC  –  десятичный,  ASC  –  символы 
таблицы ASCII);

• D0  …  D7  [байты  данных]  –  значения  байтов  поля 
данных кадра от первого до восьмого в зависимости от 
длины  поля  данных,  если  поле  пусто,  то 
соответствующий  байт  данных  отсутствует  в  кадре; 
если получен RTR кадр это поле оставляется пустым; 
данные выводятся в формате выбранном пользователем 
(HEX, DEC, ASC);

• TIMESTAMP  [значение  отметки  времени  в 
микросекундах]  –  метки  времени  проставляются 
драйвером  в  момент  извлечения  кадра  из  регистров 
CAN-контроллера  (позволяет  оценить  интервал 
времени между моментами приема кадров);

Например: 

RX 0000002 SFF 0000003E 2 HEX FA 53                   0009376797 

означает,  что  получен  кадр  с  порядковым  номером  2, 
стандартного формата (SFF – длина идентификатора 11бит) с 
идентификатором  0x3E,  длина  данных  2,  байты  данных 
выведены в шестнадцатеричном формате  (HEX), первый байт 
данных равен 0xFA, второй – 0x53, отметка времени 9376797 
микросекунд.
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5.2. Вывод ошибок сети

Обнаруженные  в  процессе  работы  ошибки  выводятся  в 
рабочую область модуля асинхронно наряду с посланными и 
принятыми кадрами:

• “ER WTOUT   WRITE TIMEOUT       OCCURED  N 
TIMES" – произошла  (N  раз)  ошибка  Write  Timeout  - 
кадр  не  был  отослан  в  течении  стандартного 
временного интервала, ошибка может возникнуть если 
нет соединения с сетью (например, обрыв кабеля, нет 
других  контроллеров  в  сети,  несоответствие 
выставленных  скоростей  передачи  у  контроллеров  в 
сети);

• "ER EWL     ERROR WARNING LIMIT OCCURED  N 
TIMES"  –  произошла  (N  раз)  ошибка  Error Warning 
Level  -  один  из  аппаратных  счетчиков  ошибок  CAN-
контроллера  превысил  уровень  предупреждения  (по 
умолчанию 96); кроме указаных в предыдущем пункте 
(WTOUT) причиной возникновения этой ошибки могут 
быть  помехи  в  сети  (согласно  спецификации  Bosch 
CAN 2.0);

• "ER BOFF    BUS OFF             OCCURED N TIMES" – 
произошла  (N  раз)  ошибка  Bus  Off  -  контроллер 
отключен  от  сети  из-за  ошибок  (один  из  счетчиков 
ошибок  достиг  предельного  значения  255); при 
наступлении  этого  события  CAN-контроллер 
автоматически переходит в состоянии INIT;

• "ER HOVR    HARDWARE OVERRUN    OCCURED N 
TIMES" – произошло (N раз) переполнение аппаратной 
приемной  очереди  CAN-контроллера  (безвозвратно 
потерян  один  или  несколько  полученных  кадров), 
причина  –  большой  поток  кадров  в  сети,  ЦПУ  не 
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успевает  вынимать  кадры  из  аппаратной  очереди 
контроллера;

• "ER SOVR    SOFTWARE OVERRUN    OCCURED  N 
TIMES"  –  произошло  (N  раз) переполнение 
программной  приемной  очереди  драйвера 
(безвозвратно потерян один или несколько полученных 
кадров),  причина  –  большой  поток  кадров  в  сети, 
пользовательское  приложение  (в  данном  случае 
программа  CANwise)  не  успевает  вынимать  кадры из 
программной очереди драйвера;

5.3. Отправка кадров в сеть

Верхняя  строка  элементов  управления  задает  содержание 
отправляемого в сеть кадра:

• ID – идентификатор кадра;

• F/F –  формат  кадра  (SFF –  стандартный,  EFF – 
расширенный);

• RTR – флаг кадра запроса  на  передачу  RTR (кадр не 
имеет поля данных,  но имеет задаваемую длину поля 
данных);

• LEN – длина поля данных в байтах (от 0 до 8);

• [D0... D7] – байты поля данных с первого до восьмого;

• Delay (msec)  –  временная  задержка  между  посылкой 
кадров в миллисекундах;
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• Repeat –  количество  кадров  (одинаковых)  которое 

необходимо отправить в сеть;

Нижняя строка элементов управления:

• Transmit – кнопка запуска процесса передачи;

• Cancel – позволяет прервать текущий процесс передачи 
кадров до его окончания;

• Строка  прогресса  (Sent N)  –  показывает  сколько 
пакетов из запрошенного количества уже отправлено в 
сеть;

• History – диалог истории отправленных кадров, 
позволяет восстановить верхнюю строку элементов 
управления по уже отосланным ранее кадрам

 

• Clear – сбрасывает все элементы управления передачей 
кадров в значение по умолчанию;

• Group  Transmit  –  диалог  групповой  передачи  кадров 
(см. пункт «Групповая передача CAN-кадров»);

Отправляемые  в  сеть  кадры  выводятся  в  рабочую  область 
модуля наряду с полученными в том же формате. Отличие от 
принимаемых кадров состоит в следующем:

33



Модуль CANmonitor                                                Использование
• В  поле  EV [событие]  выводится  сигнатура  TX 

указывающая на отправленный кадр;

• Счетчик  отправленных  кадров  ведется  независимо  от 
счетчика  принятых  кадров  до  9  999  999  затем 
обнуляется;

• Поле TIMESTAMP отсутствует.

5.4. Групповая передача CAN-кадров

Групповая  передача  кадров  позволяет  отправлять  в  сеть 
одиночную или циклическую группу разных  CAN-кадров  (до 
16  штук) с  задаваемыми  пользователем  задержками  между 
ними.  Диалог  групповой  передачи  вызывается  по  нажатию 
кнопки «Group transmit».
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Процесс передачи запускается кнопкой  «Transmit».  Алгоритм 
просматривает  слоты  CAN-кадров,  и  если  переключатель 
слота  on/off включен – кадр отсылается в сеть, затем следует 
задержка  времени  указанная  в  поле  «Delay» и  происходит 
переход к следующемы слоту. Процесс повторяется для всех 
слотов столько раз, сколько указано в поле ввода Repeat.

Кнопка «Cancel» прерывает текущий процесс передачи, кнопка 
«Clear» сбрасывает все поля диалога в значение по умолчанию, 
кнопка «Close» закрывает диалог.

5.5. Запись трафика в лог-файл

Кнопка «Open Log» вызывает диалог выбора файла, в который 
модуль  CANmonitor автоматически  записывает  все 
принимаемые/отправляемые кадры и возникающие ошибки в 
том виде,  как  они  появляются  на  экране.  Кнопка  Close Log 
прекращает вывод в лог-файл и закрывает его.
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6. ИСПОЛЬЗОВАНИЕ ПОДГРУЖАЕМОГО 
МОДУЛЯ CANTRACER

Подгружаемый  модуль  CANtracer  выводит  все  получаемые 
CAN-кадры в виде фиксированного списка идентификаторов 
полученных кадров (столбец ID). 

Каждый  идентификатор  сопровождается  следующими 
данными:

• столбец  NUM  –  количество  полученных  кадров  с 
данным идентификатором;

• столбец F/F — формат последнего полученного кадра;

• столбец R/D – тип  последнего полученного кадра (RTR 
или кадр данных);

• столбец D0..D7 – поле данных последнего полученного 
кадра;
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• столбец  TIMESTAMP  –  отметка  времени  последнего 

полученного кадра;

Кнопка «Clear output» очищает окно вывода. Раскрывающийся 
список  перед  кнопкой  «Clear  Output»  позволяет  выбрать 
формат вывода поля данных полученного  CAN-кадра:  HEX – 
шестнадцатеричный  формат,  DEC  –  десятичный,  ASC  – 
формат ASCII.
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